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Documentation Updates 

The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  
Important Note: The initial version of this document is included in the patch package that is shipped with 
the patch release. However, this document may undergo modifications after the patch is released. To check 
for recent updates or to verify that you are using the most recent edition, visit the HP Software Manuals Site 
at: http://h20230.www2.hp.com/selfsolve/manuals 
This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 
Or click the New users - please register link on the HP Passport login page. 
You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

Note: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site:  
http://www.adobe.com/ 

http://h20229.www2.hp.com/passport-registration.html
http://www.adobe.com/
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In This Version 

Service Manager Version 9.30, build 511, Patch 5 (SM 9.30p5) includes several customer requested software 
enhancements and fixes. Refer to the sections below for information about the enhancements, fixes, and 
known issues included in this release. 
The following provides a summary of major updates included in this release. 

New Parameters 

The following list shows the new parameters that have been added in this patch release. 
System Configuration Parameters 

Client parameters for Web clients 
acceptBrowserLang 
disableLoginAutoComplete 
maskMessageDelay 

Connection parameters 
mailThreadCount  

 LDAP parameters 
ldapnosizelimitmsg  

System performance parameters 
maxgroupsperview  

usedmemcompmode 
sqlstats 

disableLoginAutoComplete 

Description 
This context parameter allows administrators to disable password auto-complete for the web client 
login page. 

When this parameter is set to false (default) and users have enabled password auto-complete in their 
web browser (for example, in Internet Explorer, from Tools > Internet 
Options > Content > Autocomplete > Settings), their password will be automatically completed 
at login. However, in a SaaS environment, administrators may want to disable password auto-
complete. 

Note: Due to a known issue in Firefox, if some users have already enabled password auto-complete 
and saved their password in Firefox before an administrator changes this parameter to true, these 
users need to manually remove their saved password; otherwise their password will still be auto-
completed even if this parameter is set to "true". 

To remove a saved password in Firefox, do the following: 

1. Click Tools > Options > Security, and click the Saved Password button. 
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2. Select the password for Service Manager, and then click Remove. Note that clicking 
the Remove All button will remove all saved passwords for all accessed web sites. 

Valid if set from 
Web tier configuration file (web.xml) 

Requires restart of Web application server? 
Yes 

Default value 
false 

Possible values 
true: Disable password auto-complete 
false: Enable password auto-complete 

Example usage 
<context-param> 
  <param-name>disableLoginAutoComplete</param-name> 
  <param-value>false</param-value> 
</context-param> 

 
See QCCR1E72378. 

acceptBrowserLang 

Description 
The acceptBrowserLanguage parameter specifies the preference for the TSO language settings if  the"lang" 
parameter is not set in the URL.  By default, the browser language preference has higher priority than the 
language defined in the operator's profile.  If you want the operator's profile language setting to take 
precedence over the browser language profile when the "lang" parameter is not set in the URL in a TSO 
environment, set this value to false. 

 Valid if set from 
Web tier configuration file (web.xml) 

Requires restart of Web application server? 
Yes 

Default value 
true 

Possible values 
false: Specifies that the operator’s profile language setting takes precedence. 
true: Specifies that the browsers language setting takes precedence. 

 Example usage 
<init-param> 
      <param-name>acceptBrowserLang</param-name> 
      <param-value>true</param-value> 
    </init-param> 

See QCCR1E73982. 

maskMessageDelay 

Description  
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The maskMessageDelay specifies the number of seconds before the mask message is displayed after 
the mask is shown. The minimum value is 1 second and the maximum is 30 seconds. A default value 
of 5 seconds will be used if any invalid value specified. 

Valid if set from 
Web tier configuration file (web.xml) 

Requires restart of Web application server? 
Yes 

Default value 
5 seconds 

Possible values 
 Any integer value from 1 second to 30 seconds.  Any invalid value will use the default value of 5 
seconds. 

Example usage 
 <context-param> 
    <param-name>maskMessageDelay</param-name> 
    <param-value>5</param-value> 
 </context-param> 

See QCCR1E77454. 

ldapnosizelimitmsg  

Description 
When limiting LDAP query with ldapmaxrecords:100 (for example), if LDAP query results are bigger 
than 100 records, users get the following message: Message from LDAP server: Size limit exceeded. 
This informational message may mislead users to think that something is not working correctly. 

This parameter, when set to 1, allows you to disable this informational message so that it will not 
display to and therefore not disturb end users. 

Valid if set from 
Server's OS command prompt 
Initialization file (sm.ini) 

Requires restart of HP Service Manager server? 
No 

Default value 
0 

Possible values 
0 (Enable the informational message) 
1 (Disable the informational message) 

Example usage 
Command line: sm -httpPort:13080 -ldapserver1:ldapparent -ldapnosizelimitmsg:1 
Initialization file: ldapnosizelimitmsg:1 

See QCCR1E31999. 

maxgroupsperview  

Description 
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This parameter defines the maximum number of groups that can be used in a view. When a user selects a 
view from the View list whose group count exceeds the limit, only the maximum allowed number of groups 
are displayed in the view, and the following message displays in the client UI: 

"Maximum number of groups (xxxx) exceeded. Please modify the view definition to reduce the number of 
groups." 

Note: This limit would be useful if a user runs a poorly created view that causes servlets to consume too 
much CPU and memory and terminates the servlets. 

Valid if set from 
Server's OS command prompt 
Initialization file (sm.ini) 

Requires restart of HP Service Manager server? 
Yes 

Default value 
5000 (groups) 

Possible values 
500 or greater. If a value less than 500 is specified, Service Manager will ignore the value and use 
500 instead. A warning message will also occur in the sm.log file: "A maxgroupsperview value less 
than 500 specified and ignored. 500 is used." 

Example usage 
Command line: sm -httpPort:13080 -maxgroupsperview:6000 
Initialization file: maxgroupsperview:6000 

See QCCR1E72836. 

mailThreadCount 

Description  

This parameter specifies the number of threads to send emails. The default value is 10. 

Example usage 
Command line:sm -emailout -mailThreadCount:10 

Note: The main email thread now reads email records from the database and places them in queue, and 
some number of other threads (N=mailThreadCount) send the emails from the queue. Therefore, there are 
now N+1 "eventout" entries in System Status instead of one entry, and the logged-in users are counted as 
N+1 instead of 1.  See QCCR1E74158. 

usedmemcompmode 

Description 

This parameter determines the calculation method for how memory usage is calculated. 
 
Valid if set from 

Initialization file (sm.ini) 

Requires restart of HP Service Manager server? 
Yes 

Default value 
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0  (The default is 0, which is the normal Service Manager method) 

Possible values 
0 (Specifies that used memory will be the sum of committed memory plus the reserved memory) 
1 (Specifies that used memory will be equal to the committed memory, but no loge entry) 
2 (Specifies that used memory will be equal to the committed memory but with a log entry.) 

Example usage 
Initialization file: Usedmemcompmode:1  
(This will sum only the committed memory when computing the used memory, and will not generate 
a line of calculation log in sm.log.) 
Command line: sm -httpPort:13080 – usedmemcompmode:0 

See QCCR1E71853. 

sqlstats 

Description 

This parameter allows statistics from an Oracle database to log in the sm.log file. 
 
Valid if set from 

Initialization file (sm.ini) 
This parameter is only used when using an Oracle database. 

Requires restart of HP Service Manager server? 
Yes 

Default value 
0  (disabled) 

Possible values 
0 (disabled) 
1 (enabled) 

Example usage 
Initialization file: sqlstats:1  
Command line: sm -httpPort:13080 –sqlstats:1 

See QCCR1E79951. 

Keyword Highlighting in KM Optional 

In previous versions of SM, when users perform a Knowledge Management search, keywords in both 
document bodies and attachments are highlighted in the search results. This could significantly increase the 
response time when there are large attachments like PDF manuals. To solve this issue, Service Manager 
9.30 provides an option that allows administrators to choose whether to highlight keywords only in 
document bodies or highlight them in both document bodies and attachments. 
To use this new feature, you must complete the following steps as an administrator. 
1. Install the 9.30p5 server package.  

Note: The server package will update your schemastub.xml file to support this new feature. If you do not 
want to use this feature, copy your old schemastub.xml file back from the backup of your 
RUN\km\styles directory in order for your Search Engine continue to work.  
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1 Make a backup of your Search Engine installation folder. 

2 Overwrite your Search Engine’s kmsearchengine folder (for example: C:\Program Files 
(x86)\HP\Service Manager 9.30\Search_Engine\kmsearchengine) with the new one from the 9.30p5 
KM package. 

3 Load the QCCR1E77409_SM930P5_SM930.unl into Service Manager.   
Note: You must load QCCR1E67750_SM930P5_SM930.unl first if you plan to load both unload files. 
If you ignore the rest of the steps, when users perform a Knowledge Management search, keywords in 
attachments will not be highlighted in the search results. You can continue to complete the following 
steps to update the KM environment form to add a new option. 

4 Enable the new option in the KM environment record. 

a Open the environment record in Database Dictionary. 

b Add the following field: 
— Name: att.hl 
— Type: logical 

c Open the environment.km.g form in Forms Designer, and then click Design.  

d Add a Checkbox widget with the following properties: 
— Input: att.hl 
— Label: Highlight Attachment Keywords in Search Results? 

e Save the form. 

f Go to Knowledge Management > Administration > Environment. The new checkbox displays 
in the form. 

g To highlight keywords in attachments, select the checkbox; otherwise leave it unchecked. 

5 Log off Service Manager and log back in for your changes to take effect. 

6 Perform a full re-index on the Knowledge database. 

7 Perform a Knowledge Management search using a keyword, and verify the search results are displayed 
as expected: If you selected the new checkbox in the KM environment record, the keyword is highlighted 
in both document bodies and attachments; otherwise the keyword is highlighted only in document 
bodies.  

KM Search Behavior is Changed When Excluding Terms 

When searching Knowledge Management and specifying certain terms to be excluded, results were 
inconsistent.  For example, searches for X that used the “None of these Words” option would exclude “ X “ 
from  the Search Results.  However, the search results would still include items that contained the term plus 
a punctuation mark, such as “X:”  
To resolve this issue, the behavior of the “None of these Words” option has been changed to exclude all 
instances of the search terms.  See QCCR1E75104. 

Expanded Groups Collapse After Auto-Refresh 

Previously, there were issues in using the auto-refresh feature with the expanded group expands after 
refreshing the page.  
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Limitations: 
1. Currently we can only resume the expansion state in the TODO page. We cannot apply this behavior 

in the list/detail page. 
2. The group expansion state now can only be kept for one level group. If have sub-group, this state 

cannot be saved when refreshing. 
3. If the queue or view changes (for example, a record is moved to a different group), and then you 

return to the original queue or view, the expansion state cannot be recovered. 
See QCCR1E64195. 

Web Tier Mask Transparency and Timing Changes 

The appearance of the Web tier mask has been changed so that it is now transparent be default.  The mask 
opacity can still be adjusted by modifying the relevant values in the HPOV.css file.  In addition, the duration 
until the appearance of the mask message is now configurable, through the introduction of the new 
maskMessageDelay parameter.  For more information on how to adjust the mask opacity and the 
maskMessageDelay parameter, refer to the “Using the Mask and Timeout Parameters in HP Service 
Manager” white paper on the following HP Software support Web site: 

 www.hp.com/go/hpsoftwaresupport 

Upgrade to LW-SSO v2.5 (Server and Web Tier) 

As of version 9.30p5, the Service Manager Web tier and server have upgraded to LW-SSO version 2.5. 
In the Web tier’s lwssofmconf.xml file, a new parameter, secureHTTPCookie, has been introduced. The 
default is "true". This parameter must be set in combination with the secureLogin parameter in the Web tier 
configuration file (web.xml) so that LW-SSO can work correctly: 

• If secureHTTPCookie is set to true, secureLogin must also be set to true;  

• If secureHTTPCookie is set to false, secureLogin can be set to true or false as needed (you are 
recommended to set both to true in a production environment).    

 

  

http://www.hp.com/go/hpsoftwaresupport
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Fixes 

Web Client 

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E31291 DVDs for tables do not work correctly for Bold 
and Italic conditions on the Web client. 

DVDs for tables work as expected for Bold 
and Italic conditions on the Web client. 

QCCR1E64183 There is no pop-up window to save the 
generated file when using Internet Explorer 
to generate an unload file. 
 
Note: This feature works correctly in FireFox. 

The issue was resolved by changing the 
messages used to generate the unload file 
from <xml> to <div> tags, so that IE can 
render the messages properly. 
Known issue in IE7 /IE8: 
The generated unload file will be blocked 
by IE with the default settings and the 
following message will be shown at the top 
of current page: "To help protect your 
security, Internet Explorer blocked this 
site from downloading files to your 
computer...." 
To avoid this known issue, perform the 
following steps to apply specific setting in 
IE7/IE8:  

1. Click Tools > Internet Options. 
2. Click the Security tab, and then 

click Custom level.  
3. Scroll to the Downloads section of 

the list, and then, under 
"Automatic prompting for file 
downloads", click Enable.  

4. Click OK, click Yes to confirm that 
you want to make the change, and 
then click OK again. 

QCCR1E64195 On auto-refresh of a queue, previously 
expanded groups should not collapse. 

The expanded group expands after 
refreshing the page.  
 
Limitations: 

1. Currently we can only resume the 
expansion state in the TODO 
page. We cannot apply this 
behavior in the list/detail page. 

2. The group expansion state now 
can only be kept for one level 
group. If have sub-group, this 
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Global ID Problem Solution 
state cannot be saved when 
refreshing. 

3. If the queue or view changes (for 
example, a record is moved to a 
different group), and then you 
return to the original queue or 
view, the expansion state cannot 
be recovered. 

QCCR1E66592 The web client does not honor the 
Justification properties defined in Forms 
Designer. 

The web client now honors the 
Justification properties defined in Forms 
Designer. 

QCCR1E67135 Web client combo boxes do not clear 
dependent field values when a parent value is 
changed. 

Web client combo boxes clear dependent 
field values when a parent value is 
changed. 

QCCR1E67759 When a Timer widget that exists on a 
background tab (for example, the Incident 
queue screen) expires, the active tab (for 
example, the Incident detail screen) 
disappears and the timer on the background 
tab begins to count in the opposite direction. 
In addition, the background tab becomes 
unresponsive. 

The timer's data change event is now 
disabled when the tab is not active. 
Additionally, the timer now immediately 
submits the data change event if the user 
returns to this tab and the timer has 
expired. 

QCCR1E68839 When the "Group rendering enabled" 
Notebook widget Property is set, form 
sections do not expand in the Web client. 

When the "Group rendering enabled" 
Notebook widget Property set, form 
sections will expand as expected in the 
Web client. 

QCCR1E69798 The List Builder works differently in the Web 
client than when used in the Windows 
(desktop) client. 

The List Builder now works correctly in 
both Web client and Windows client. 

QCCR1E70010 In a system configured with LWSSO and 
BSF, you are not redirected to the correct 
page after re-logging in. After clicking "Login 
Again" and typing your user name and 
password in the BSF login form, you are 
redirected to a .css file or an image file 
instead of to the Service Manager index page. 

In a system configured with LWSSO and 
BSF, you will be correctly redirected to 
SM index page when you click the "Login 
again" link in the goodbye page. 

QCCR1E70711 When you terminate a background process 
using the System Status format in the web 
client, the System Status format is partially 
hidden behind the System Navigator. 

System status screen will display 
completely after page being refreshed. 

QCCR1E70983 If you expand and then collapse a group when 
the vertical scroll bar is near the middle of 
the window, the message box quickly moves 
to the middle of the screen. This occurs with 

Message bar goes to the correct position 
by repositioning the message bar on each 
collapsing of section. 
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Global ID Problem Solution 
multiple modules in the Service Manager web 
client when using Internet Explorer. 

QCCR1E71070 After a failed attempt of an employee self-
service (ESS) user to access Service Manager, 
the client session still remains for that user. 
This issue occurs in an LWSSO-enabled 
environment. 

The web client now terminates the session 
before forwarding the request to the 
authFailure.jsp page. 

QCCR1E71234 An error occurs and an 'invalid hash' results 
in the Web client when the query is 
configured as follows: 
(close.time>(val(str("01/"+$G.last.month+"/"+
$G.year),3)) and 
close.time<(val(str("01/"+month(tod())+"/"+$G.
year),3)) ) 
Additionally, the Tomcat access log shows an 
HTTP 500 error. 

No error occurs when accessing MySM in 
the Web client when config query has a 
variable. 

QCCR1E71386 In the Change Category, the phases that are 
added in the Workflow exceed the canvas of 
the Workflow viewer. 

Now, the view is restricted to the canvas 
area only and scrollbars will appear to 
scroll through the whole graph as needed. 

QCCR1E71677 As users open more QBE lists in the web 
client, the size of the "Tablexx" cookie may 
increase to exceed the limit. 

Now, data that was previously stored in 
the cookie is now saved in session storage. 

QCCR1E71685 The "Type Ahead" function in the web client 
for Select Only fields does not keep up with 
the average user typing speed. 

The "Type Ahead" function now can keep 
up with the average user typing speed. 

QCCR1E71962 After logging into Service Manager with a 
user name that uses a different case than 
what is saved in the LDAP account, favorites 
are able to be created but not saved. 

Users can now create, save, or 
view favorites after logging in with case-
insensitive user names against LDAP. 

QCCR1E72238 When you click on the MySM link in the Web 
client, you are logged out. 

Use "Constants" to replace the 'static 
import' in the following JSP files:  
 
sm_mashup.jsp 
smerror.jsp 
uimComponent.jsp 
queryFilter.jsp. 

QCCR1E72357 Unable to launch the RAD application 
us.launch.external when the current thread is 
listdetail or MySM. 

The us.launch.external RAD application 
now launches as expected when the 
current thread is listdetail or MySM. 

QCCR1E72378 The web client allows password auto-complete 
with no option to disable the auto-complete 
feature. For example, in Internet Explorer, 
users can enable password auto-complete 
from Tools > Internet Options > Content > 

A new context parameter in web.xml, 
disableLoginAutoComplete, has been 
introduced to allow users to enable or 
disable password auto-complete on login 
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Global ID Problem Solution 
Autocomplete > Settings. when set to one of the following values: 

- true: Disable password auto-complete 
- false: Enable password auto-complete 
 
Note:  
Due to a known issue in Firefox, if users 
have already enabled auto-complete and 
saved their password, they will have to 
manually remove their saved password; 
otherwise their password will still be 
auto-completed even if the 
disableLoginAutoComplete parameter is 
set to "true".  To remove a saved password 
in Firefox,do the following: 
 

1. Click Tools > Options > Security, 
and click the "Saved Password" 
button. 

2. Select the password for Service 
Manager, and then click 
"Remove". Warning: Clicking the 
"Remove All" button will remove 
all saved passwords for all 
accessed web sites. 

See disableLoginAutoComplete. 

QCCR1E72436 Users cannot relate incidents to other 
incidents in the Web client. 

Users can relate incidents by entering or 
searching records in the Web client. 

QCCR1E72468 The Dynamic View Dependency for checkbox 
controls is evaluated incorrectly in the Web 
client. For example, if you set the "Selected 
Condition" property to a variable that 
evaluates to false, the check box will be 
unchecked in the Windows client but checked 
in the Web client. 

The Dynamic View Dependency for 
checkbox controls is now evaluated 
correctly in the Web client. 

QCCR1E72743 The Web client ignores the "Invisible" settings 
in the fields of the "Data policy" table. 

The Web client no longer ignores the 
"Invisible" settings in the fields of the 
"Data policy" table.  

QCCR1E73055 DVDs do not behave consistently across 
Windows and Web client in Service Manager. 

DVDs behave consistently across 
Windows and Web client in Service 
Manager. 

QCCR1E73103 Some users are unexpectedly logged out from 
the Web client when the number of cookies 
exceeds the limit specified by Internet 
Explorer. 

The issue is fixed by reducing the number 
of cookies used by web client. 
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Global ID Problem Solution 

QCCR1E73839 When selecting backspace on a field, the 
record sometimes refreshes and logs the user 
out of Web client. 

When selecting backspace on a field, the 
record no longer refreshes and log the 
user out of Web client. 

QCCR1E73982 When trusted sign-on is enabled, the Web 
client uses the language specified in the 
operator record, instead of "lang" parameter 
passed in by the Ess.do url. 

For Web client, in WEB-INF/web.xml, a 
new servlet parameter, 
acceptBrowserLang was added.  
 
By default, this value is true. If this value 
is true, the Web client will take the 
browser's language setting as the first 
priority in TSO mode when the “lang” 
parameter is passed in the URL. If the 
value is set to false, the Web client will 
use the language setting in the operator's 
profile. 
See acceptBrowserLang. 

QCCR1E74013 By default, the MaxFileSize value of 
log4j.appender.R is only 100K. This value 
should be increased. 

Now by default, the maximum file size for 
sm web client log "sm.log" is increased to 
5000K and up to 10 rolling files can be 
kept. 

QCCR1E74132 When resizing a column in the ToDo list view 
on the web client, all other columns are also 
resized. This behavior often resizes columns 
that were already very narrow to a size where 
no information can be displayed. 

Now, with the horizontal scroll bar 
enabled, when resizing a column in the 
ToDo list view on the web client, only the 
selected column is resized and the rest 
remain unchanged.  
 
Known issue:  
If users adjust the width of some columns 
and then change the browser zoom size 
(for example, from 100% to 120%) or 
screen resolution (for example, change the 
display to show on another monitor or 
projector connected to the computer), the 
whole table may be resized, causing 
unexpected re-adjustment of all columns. 

QCCR1E74359 When using "Save as view" in the Web client, 
the message box hangs and the "Yes" or "No" 
buttons cannot be clicked. 

The "Save as view" feature no longer 
hangs. 

QCCR1E74421 MySM cannot work in a TSO environment. MySM can now work in a TSO 
environment. 

QCCR1E74648 End users' Web tier sessions are terminated 
unexpectedly. When the users try to log in 
again, the following message is received:  
 
"Authentication failed. Contact your system 
administrator for assistance" 

The Web tier will now work on 
LWSSO_COOKIE_KEY only once from 
client to server. 
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Global ID Problem Solution 

QCCR1E74958 Collapse/Expand frames in the accessible Web 
client (accessible.do) does not work 
successfully using Internet Explorer 8. 

Collapse/Expand frames in the accessible 
Web client (accessible.do) work 
successfully. 

QCCR1E75391 In a Web tier form, a changed field retains the 
old value after the form is saved, re-opened 
and then the field is cleared and replaced by a 
space character. 

The changed field will not revert to the 
original value when saved. 

QCCR1E75426 Session is terminated for pages containing 
changePlan editor and viewer if database is 
configured to case-sensitive mode. 

Now changePlan editor and viewer work 
fine with case-sensitive database. 

QCCR1E75430 When js debug is set to true in web.xml, the 
Change Model Editor cannot be launched. 

Now the Change Model Editor can be 
launched successfully when js debug is set 
to true in the web.xml file. 

QCCR1E75428 Disable Change Plan editor and Graph 
Viewer Widget from Forms Designer and 
enable Change Model task editor and 
workflow viewer. 

Removed icons from the FD toolbar which 
give access to the Change Plan editor and 
Graph Viewer Widget and enabled old 
widgets (i.e. task editor and workflow 
viewer). 

QCCR1E75951 In a system using a Cyrillic database, the 
popup (hover) sub-format displays "No record 
found" if the field value contains Russian 
characters. 

The popup(hover) sub-format now 
displays content as expected. 

QCCR1E77454 By default, the mask is always grey. If the 
mask were transparent, it would avoid the 
appearance of poor performance. 

The default mask is now transparent. In 
addition, a new web.xml parameter 
maskMessageDelay is introduced to 
specify the number of seconds that should 
elapse before the loading message on the 
mask is displayed. Note that if a value 
greater than 15 is specified for the 
maskMessageDelay parameter, the 
loading message displays 15 seconds later 
anyway if a JavaScript error caused hang 
issue has been detected. 

QCCR1E78076 Records cannot be displayed by using the 
Find function on a read-only field in the Web 
tier. When this issue occurs, the user receives 
the following message:  
"No link exists for this field, find function 
cannot be performed." 

The webtier can find the related info when 
the field is read-only. 
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Windows Client 

The following item (identified by reference number) is fixed in the current software release.  

Global ID Problem Solution 

QCCR1E52075 In the Service Manager Windows 
client, a user cannot scroll in a read-
only multi-line text box window by 
using the mouse wheel. The slider to 
the right of the window must be used 
instead.  
 
Note: Mouse wheel scrolling works, if 
the field is read-write. 

In Windows client, focus can be set on a read-
only multi-line text widget and the scroll bar 
responds when using the mouse wheel. 

QCCR1E73743 When a groupby clause is specified, an 
SM process may attempt to fetch all 
the records from the database. 

When a groupby clause is used, only the last 
group is retrieved.  
Note: All rows are fetched only when no groupby 
clause is specified. 

QCCR1E74470 When opening a Template, selecting 
the HTML Source Tab -> Source, and 
then selecting another Template, the 
content in the editor is not reloaded. 
However, if the user clicks Save, the 
newly-selected item is overwritten with 
the HTML-Source from the previous 
Item. 

HTML source tab will refresh correctly when 
switching from htmltemplates. 

QCCR1E78105 Print and Print Preview are not 
working in SC 6.2.8.8 and later 
versions. 

Print and Print Preview can work in the 
Windows client as expected. 

Application 

The following item (identified by reference number) is fixed in the current software release.  

Global ID Problem  Solution  

QCCR1E71099 Users need to display Value Lists 
instead of the data directly retrieved 
from the database in a QBE list when 
adding a field by using Modify Columns. 

Value Lists can be displayed instead of the 
data directly retrieved from the database in a 
QBE list when adding a field by using Modify 
Columns. To achieve this, it requires both the 
current patch release and the 
QCCR1E71099_SM930P5_SM930.unl file). 
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Global ID Problem  Solution  

QCCR1E71139 When Service Manager is configured to 
use LDAP as the authentication data 
source, the user is still forced to change 
the password if the user is expired in 
the local database. 

When Service Manager is configured to use 
LDAP as the authentication data source, the 
user will not be forced to change the password 
if the user is expired in the local database.  
The fix includes an unload file 
QCCR1E71139_SM930P5_SM930.unl, which 
can be obtained from the platform_unloads 
directory. 

QCCR1E75104 Searches that use "NOT" or '-' to exclude 
terms produces unexpected results. For 
example, the search results when using 
the 'None of these words' option in 
Advanced Search may include the 
search terms that should have been 
excluded. 

Reconstructed the query string for "None of 
these words".  
Specifically, the behavior of all the "Filter 
by..." fields ("All of these words", "The exact 
phrase", "Any of these words" and "None of 
these words") are aligned and put into the 
filter query.  
Consequently, the words in these 4 fields are 
not going to be highlighted; This is because of 
the "filter by..." is meant to limit the search 
scope before actually query. 

QCCR1E77409 When search results contain large 
documents (for example, software 
manuals in pdf format), the search 
response time is significantly longer. 
This behavior occurs because the 
content of the attachments is added to 
the "docbody_lang" field. Highlighting 
on this field takes a lot more processing 
time to markup the entire document. 

Added a new "attachment"field for 
attachment which will not be highlighted. 

QCCR1E79583 Language selection from eclipse client is 
not valid after applying the unload file 
QCCR1E71139_SM930P4_SM930.unl. 

The unload file has been corrected and the 
language selection now works as expected. 

Mobility 

The following item (identified by reference number) is fixed in the current software release.  

Global ID Problem Solution 

QCCR1E73885 An upper-case user name fails to log in 
to the Mobility Client when Service 
Manager (SM) uses a case-insensitive 
DB. 

This issue was fixed by separating the login 
name and the user name that is used to connect 
to the RTE server. This ensures that the same 
user name for the RTE connection is always 
used. 
Now users can successfully log in to the Mobility 
Client with upper-case, lower-case or mixed-case 
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Global ID Problem Solution 
user names when SM uses a case-insensitive DB. 

Server  

The following items are fixed in the current software release.  

Global ID Problem  Solution  

QCCR1E31999 Users are receiving a confusing error 
message when LDAP query results 
exceed the maximum size (100 records, 
for example). The message should be 
available only in the log file for 
debugging purposes, rather than 
displaying in the Service Manager 
client window. 

Added a new parameter ldapnosizelimitmsg, 
which allows system administrators to disable 
the LDAP size limit message. See the following 
for a description of this parameter. 
 
Parameter  
ldapnosizelimitmsg  
Description  
When limiting LDAP query with 
ldapmaxrecords:100 (for example), if LDAP 
query results are bigger than 100 records, users 
get the following message: Message from LDAP 
server: Size limit exceeded. This informational 
message may mislead users to think that 
something is not working correctly. 
This parameter, when set to 1, disables this 
informational message so that it will not display 
to and therefore not disturb end users. 
Valid if set from  
Server's OS command prompt  
Initialization file (sm.ini)  
Requires restart of HP Service Manager server?  
No  
Default value  
0  
Possible values  
0 (Enable the informational message)  
1 (Disable the informational message)  
Example usage  
Command line: sm -httpPort:13080 -
ldapserver1:ldapparent -ldapnosizelimitmsg:1  
Initialization file: ldapnosizelimitmsg:1 
See ldapnosizelimitmsg. 

QCCR1E54248 When Service Manager processes a web 
service request and sends a response, 
the response is not understood by the 
requesting application. This behavior 
results in the following error message: 
"type" attribute in <cmn:messages> tag 
not matching Common.xsd schema 
definitions. 

A code change was implemnted in Common.xsd, 
so that "StringType" is always used as the base 
type of "MessageType." 
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QCCR1E67562 Request for a way of turning off the 
"Triggers have been turned on" and 
"Triggers have been turned off" 
messages in the log file. 

Now, you can use the rtm parameter to turn the 
"Triggers have been turned on" and "Triggers 
have been turned off" messages on or off. 
To turn messages on, set the value of the rtm 
parameter equal or greater than 2. 

QCCR1E71099 Users need to display Value Lists 
instead of the data directly retrieved 
from the database in a QBE list when 
adding a field by using Modify 
Columns. 

Value Lists can be displayed instead of the data 
directly retrieved from the database in a QBE 
list when adding a field by using Modify 
Columns. To achieve this, it requires both the 
current patch release and the 
QCCR1E71099_SM930P5_SM930.unl file). 

QCCR1E71139 When Service Manager is configured to 
use LDAP as the authentication data 
source, the user is still forced to change 
the password if the user is expired in 
the local database. 

When Service Manager is configured to use 
LDAP as the authentication data source, the 
user will not be forced to change the password if 
the user is expired in the local database.  
The fix includes an unload file 
QCCR1E71139_SM930P5_SM930.unl, which can 
be obtained from the platform_unloads directory. 

QCCR1E71391 If the content contains no HTML tags 
but still contains the "<" character, 
after clicking the "Use Solution" button 
in Knowledge Management, the 
HTMLtoText function encounters an 
infinite loop and a JAVA out of memory 
exception. 

Now the HTMLtoText function no longer 
encounters an infinite loop and a JAVA out of 
memory exception when the content contains no 
HTML tags but still contains the "<" character. 

QCCR1E71853 The "NativeMemory" size never 
shrinks. 

To resolve this issue, the usedmemcompmode 
parameter has been added. This parameter 
determines how used memory is calculated 
according to the following: 
 
0:used=committed + reserved;  
1:used=committed,no log;  
2:used=committed,log.  
 
The default is 0, which is the old Service 
Manager method. 
See usedmemcompmode. 

QCCR1E71999 The Service Manager log contains lock-
failure messages: 
org.jgroups.blocks.LockNotReleasedExc
eption: Lock cannot be unlocked when 
session terminates. 

When a session ends, no unlock failure is 
reported. 

QCCR1E72566 Service Manager performance on the 
AIX platform is significantly worse 
than other platforms when multiple 
users are executing workflows that 
make heavy use of Javascript. 

Optimized JavaScript execution in SM for AIX so 
that property names are only retrieved as 
needed. 
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QCCR1E72614 The connection to the server is lost 
when you try to view an Incident in the 
TODO list and the memdebug debug is 
set to 1 in the sm.ini file. 

The connection is no longer lost. 

QCCR1E72743 The Web client ignores the "Invisible" 
settings in the fields of the "Data 
policy" table. 

The Web client no longer ignores the "Invisible" 
settings in the fields of the "Data policy" table. 
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QCCR1E72836 There is no limit on the number of 
records an SM Process can try to fetch. 
A limit would be useful if a user runs a 
poorly created view that causes 
servlets to consume too much CPU and 
memory and terminates the servlets. 

Added a parameter maxgroupsperview to limit 
the number of groups allowed in a view.  
 
Startup parameter: maxgroupsperview  
Startup parameters change the behavior of the 
HP Service Manager server. You can always set 
a startup parameter from the server's OS 
command prompt.  
 
Parameter  
maxgroupsperview  
 
Description  
This parameter defines the maximum number of 
groups that can be used in a view. When a user 
selects a view from the View list whose group 
count exceeds the limit, only the maximum 
allowed number of groups are displayed in the 
view, and the following message displays in the 
client UI:  
"Maximum number of groups (xxxx) exceeded. 
Please modify the view definition to reduce the 
number of groups."  
 
Valid if set from  
Server's OS command prompt  
Initialization file (sm.ini)  
 
Requires restart of HP Service Manager server?  
Yes  
 
Default value  
5000 (groups)  
 
Possible values  
500 or greater (if a value less than 500 is 
specified, Service Manager will ignore the value 
and use 500 instead. A warning message will 
also occur in the sm.log file: "A 
maxgroupsperview value less than 500 specified 
and ignored. 500 is used.")  
 
Example usage  
Command line: sm -httpPort:13080 -
maxgroupsperview:6000  
Initialization file: maxgroupsperview:6000 
See maxgroupsperview. 

QCCR1E72977 An XML Error is received when a 
solution field that contains special 
characters is updated in an SM 
Incident that was created by OMi. 

Service Manager can now send special characters 
to OMi by using valid encoding. 
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QCCR1E72908 Shared Memory Initialization of 
Service Manager process is very slow, 
potentially taking over 30 seconds. 

Optimized the Service Manager process startup 
procedure to only load the data in SCAccess and 
SCFolderAccess files on demand. 

QCCR1E73159 If the mailFrom parameter is 
configured in sm.ini or sm.cfg, Service 
Manager always uses the mailFrom 
value as the Mail From address for 
Service Manager mail. However, if the 
mailFrom parameter is not configured, 
when the user "falcon" sends a message 
to recipient@domain.com, an Eventout 
record is generated with an External 
Information String in the following 
format: 
recipient@domain.com^falcon^recipien
t@domain.com<html>test</html> 
 
Service Manager will then log an 
exception in the sm.log file because 
there is no Mail From value. The 
expected behavior is that Service 
Manager uses "falcon" as the Mail 
From value. 

Service Manager will now process the "Mail 
From" value of an EventOut record as follows: 
 
1. If the mailFrom parameter is configured in the 
sm.ini or sm.cfg file, SM willalways use the value 
of mailFrom as the Mail From address. 
2. If the mailFrom parameter is not configured in 
the sm.ini or sm.cfg file, SM will always use the 
value of the Mail From value of the Eventout 
record as the Mail From address without 
checking if the value is a valid email address. 
3. If there is no mailFrom value configured in 
smi.ini or sm.cfg and no Mail From value in the 
Eventout record, SM logs an exception in sm.log. 

QCCR1E73384 During normal operation of the HP 
Operations Orchestration 7 integration 
with Service Manager 7.11, the Service 
Manager server refuses Web service 
connections and issues the following 
warnings: 
"Server low on memory" 

This issue is caused by a memory leak. To solve 
this issue, a close() method is now called on the 
Page reference of the Lexer html parser to 
release the memory. 

QCCR1E73406 A memory leak that is caused by 
GZIPInputStream makes the system 
unresponsive. 

The resource is now closed properly. 

QCCR1E73466 To use TSO, the ssl parameter must be 
set to 1 on the RTE side, and all clients 
are required to have certificates. This 
requirement prevents using HTTP and 
HTTPS sessions on the same servlet. 
 

Now, you can configure the SSL parameter to 0 
(ssl:0).  By doing this, the servlet can accept both 
TSO and non-TSO connections. 
 
Note: You should always configure the 
parameter ssl in sm.ini and always set the same 
value for all servlets. 

QCCR1E73667 Calling the scmsg() RAD function with 
invalid parameters results in a "Signal 
11" error and terminates the session. 

Updated the code to pass the correct arguments 
value to the scmsg() RAD function. 
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QCCR1E73782 A "Signal 11" error is generated when 
initializing LDAP and the following 
error message is logged in the SM.log 
file many times: 
 
"A signal 11 was raised in native code. 
Client terminated. Error: Win32 
Exception:0xC0000005 (instruction 
0x61DFF440 while reading address 
0x00000000)" 

The "Signal 11" error is no longer generated 
when initializing LDAP. Now the SM application 
can handle the exception by logging the following 
information in the sm.log file: 
 
The ldapserver isn't set in scldapconfig. 

QCCR1E73864 The server process consumes a lot of 
memory and time when the "Go to last 
page" button is clicked from the Web 
client on the list/detail screen of a 
query with thousands of returned 
records. This behavior may occur 
because of a poorly created view. This 
behavior can cause the servlets to 
consume too much CPU and memory 
and eventually terminate the servlets. 

The server process now only lasts for a few 
seconds with less memory consumed when the 
"Go to last page" button is clicked on the 
list/detail screen of a query with thousands of 
returned records. This behavior will no longer 
terminates the servlets. 

QCCR1E74088 Service Manager issues a message that 
indicates the license count is greater 
than the number of logged in users. 
This behavior may occur when a 
session is terminated during login. 

Change the standard to judge whether a user 
has logged in.  During log in, when a user record 
is inserted into database, the LoginStatus should 
be set to true. 

QCCR1E74101 Users cannot log in after starting a 
servlet, and the following message is 
logged: 
 
RTE E EVP_PBE_CipherInit() failed in 
desEncryptPasswordFieldWithMD5An
dDes() 

This issue occurred because of a concurrent call 
to the OpenSSL crypto library. This has been 
resolved so that the call will no longer impact the 
log in to Service Manager. 

QCCR1E74131 When using a case-insensitive 
database, the operator() routine does 
not return the correct user name to a 
Web service client. For example, when 
you log on as "FALCON" or as "Falcon" 
by using the Eclipse or Web client, the 
operator() routine returns 
"falcon." However, when you log on as 
"FALCON" by using a Web service 
client, the operator() routine returns 
"FALCON."  
 
This behavior impacts all Web services 
clients, such as RC and Mobility. 

When using a case-insensitive database, the 
operator() routine returns the correct user name 
to a Web service client. 
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QCCR1E74158 After upgrading to Service Manager 
9.30 Patch 3, the backlog of email 
notifications grows quickly when the 
system is sending thousands of emails 
every hour. 

The performance of sending email notifications 
now has been significantly enhanced. 
 
A new parameter "mailThreadCount" is 
introduced in the sm.ini file to specify the 
number of threads to send emails. The default 
value is 10. 
Example of command line: sm -emailout -
mailThreadCount:10 
 
The main email thread now reads email records 
from the database and places them in queue, and 
some number of other 
threads (N=mailThreadCount) send the emails 
from the queue. Therefore, there are now N+1 
"eventout" entries in System Status instead of 
one entry, and the logged-in users are counted as 
N+1 instead of 1. 
See mailThreadCount. 

QCCR1E74314 When a session fails with a "Signal 11" 
error, the attempt to handle the signal 
results in another "Signal 11" error. 
This second "Signal 11" error causes 
the thread to enter a sleep state. This 
behavior, in turn, causes problems in 
Connect-It. 

This is resolved by adding several userp/tuserp 
checks so that sytermClean() is called multiple 
times. 

QCCR1E74313 A "Signal 11" encountered while 
terminating a session locks a 
semaphore. This causes the system to 
hang and prevents any other users 
from logging in. 

All critical resources are now released when a 
session terminates. 

QCCR1E74441 The xmlFill.getValue() ScriptLibrary 
function fails with a "Signal 11" error if 
it is called with malformed XML or 
with no XML at all. 

The null pointer is now checked before this 
function is called. 

QCCR1E74496 The following Signal 11 error appears 
in the RTE log file: "SQLAllocHandle( 
SQL_HANDLE_ENV, 
SQL_NULL_HANDLE, ... ) failed with 
sqlrc=-1". 

Fixes were made to prevent "Signal 11" errors 
when the DB client connects to the server, and to 
prevent possible memory leak issues in 
_allocHandles(). 

QCCR1E74495 When using Connect-It, an "uncaught 
exception" error related to 
"com.hp.ov.sm.common.core.GetThread
.initialize" appears in the RTE log file. 

In the run() function of GetThread.java, the 
initialization is now protected from exceptions 
and the call to shutdown is ensured. Additional 
exception processes for shutdown() in run() were 
added. 
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QCCR1E74537 If the Service Manager server running 
on Solaris uses "memdebug" as the 
memory manager, it occasionally 
reports the following error when 
connecting to the DB2 client: 
"EyeCatcher is missing". 

This issue was resolved by adding new memory 
allocator/deallocator interfaces so that the RTE 
will free all memory allocated by its memory 
manager. 

QCCR1E74646 Background event processes consume 
high memory usage, even though there 
are no event records to process. 

Background event processes can run 
without consuming excessive memory. 

QCCR1E74709 Webservice requests get corrupted 
when they contain inline attachments 
whose base64 encoding contains 
carriage return line feeds. 

An RTE change is made to prevent inline 
attachments containing carriage return line feed 
characters from being corrupted. 

QCCR1E74742 SLA processes are terminating 
multiple times a day, resulting in core 
dumps. 

The unexpected terminations and core dumps 
have been eliminated. 

QCCR1E75007 When receiving multiple "login" 
requests in the same session, the RTE 
calls the login process multiple times 
and the operator's "max login" 
attempts is reached. This occurs when 
using Connect-It with the debughttp:1 
parameter enabled. Multiple login 
requests in the same session will 
appear in the SM.log and http.log files. 

The login request is now skipped when the user 
is already logged in. 

QCCR1E75032 User licenses may not be released if a 
Signal error or exception occurs during 
a shutdown. 

The synchronization process will release licenses 
and resource locks as expected if a Signal error 
or exception occurs during a shutdown. 

QCCR1E75112 KM search uses an AND conjunction 
instead of OR in the standard fields. 
The search should behave in the same 
manner as the previous version of the 
Knowledge Base.  
 
The solrconfig.xml in SearchEngine 
server should add an "mm" 
configuration item with a value set to 
0. Currently, the default value for this 
item is 100% which means AND. A 
value of 0 means OR. 

The solrconfig.xml in SearchEngine server adds 
an "mm" configuration item with a value set to 0. 



 26 

QCCR1E75104 Searches that use "NOT" or '-' to 
exclude terms produces unexpected 
results. For example, the search results 
when using the 'None of these words' 
option in Advanced Search may include 
the search terms that should have been 
excluded. 

Reconstructed the query string for "None of these 
words".  
 
Specifically, the behavior of all the "Filter by..." 
fields ("All of these words", "The exact phrase", 
"Any of these words" and "None of these words") 
are aligned and put into the filter query.  
 
Consequently, the words in these 4 fields are not 
going to be highlighted; This is because of the 
"filter by..." is meant to limit the search scope 
before actually query. 

QCCR1E75338 When an encrypted PDF is submitted 
to KM using SOLR, the security 
settings prevent page extraction and 
cause the KM reindex to fail. This 
behavior does not occur with K2. 

When an encrypted PDF is submitted to KM 
using SOLR, the PDF can be indexed correctly. 

QCCR1E76040 A "Selected record is not in set" 
message is received when switching a 
view in the TODO Queue. 

The incorrect condition that triggered this error 
message has been fixed and the following 
behavior will now occur:  
1) If a record was DELETED from the database 
by user A, and another user B, who was viewing 
the same queue tries to click that record, the 
message "Selected record is not in set" will be 
sent to the user B, but not user A.  
2) If a case is CLOSED (not DELETED), neither 
user A nor user B will see this message.  
 
Note: The workaround is no longer necessary. 

QCCR1E76337 If you add non-existing fields to a view, 
a generated query is "select * " instead 
of "select valid_col1, valid_col2, 
valid_col3." 

Now, a generated query is "select valid_col1, 
valid_col2, valid_col3."  Additionally, warning 
messages  
will be printed to the log file. 

QCCR1E76365 A memory leak may occur when the 
javascript object system.sysinfo is 
called. 

No memory leak will occur when the javascript 
object system.sysinfo is called. 

QCCR1E76660 Colon appears in the converted date 
when using the getTime() JavaScript 
function. 

This issue occurred because the current 
js_1.5rc6a.dll is built with Microsoft Visual 
Studio 2003 and there is a defect within the 
function for converting a double to a string. This 
issue was resolved by rebuilding the DLL with 
Microsoft Visual Studio 2008. 

QCCR1E76737  
Service Manager process hangs and 
cannot send any more messages to the 
cluster. 
 

 
Service Manager process can communicate to the 
cluster without any issues. 
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QCCR1E76968 A "Web service negative start attribute, 
start from first record" message is 
logged for Web Service Integrations at 
the rate of about 10K per hour. 

If the start attribute has no value in the SOAP 
request, the message "Web service negative start 
attribute, start from first record" will no longer 
be printed. 

QCCR1E77027 When the RTE fails during the 
initialization process, it might unhook 
twice and lead to shared memory 
corruption. This behavior causes one of 
the SM Servers (nodes) to generate 
core dumps and causes all other 
Servers fail. 

Now, only the last SM process cleans up the 
shared IPC. 

QCCR1E77265 The following error is received when 
invoking the "Define views" button:  
 
Invalid syntax for query. Failed 
parsing (view.define,setup.display.1) 

The error is no longer received and the define 
views window appears as expected. 

QCCR1E77409 When search results contain large 
documents (for example, software 
manuals in pdf format), the search 
response time is significantly longer. 
This behavior occurs because the 
content of the attachments is added to 
the "docbody_lang" field. Highlighting 
on this field takes a lot more processing 
time to markup the entire document. 

Added a new "attachment"field for attachment 
which will not be highlighted. 

QCCR1E78007 Logging in to SM 9.30 Patch 4 and then 
logging out causes a large memory 
leak. When repeated, this leak can 
grow quite large. 

The memory leak will not occur. 

Documentation 

The following item (identified by reference number) is fixed in the current software release.  

Global ID Problem Solution 

QCCR1E75578 The Service Manager help states that 
the default value of the soap12binding 
parameter is "1" which is incorrect. 

Updated the parameter description and default 
value as the following. 
Startup parameter: soap12binding 
Startup parameters change the behavior of the 
server. 
Parameter 
soap12binding 
Description 
Service Manager by default generates WSDLs 
conforming to soap 1.1 binding. However some 
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Global ID Problem Solution 
Web Services clients accept both soap 1.1 and 
soap 1.2. In such cases, you can enable 
soap12binding by providing the parameter 
soap12binding:1. 
 
Valid if set from 
Servers OS command promt Initialization file 
(sm.ini) 
Requires restart of server? 
Existing connections will honor the current 
value. New connections will honor the new value. 
Default value 
0 (Disabled) 
Possible values 
0 (Disabled) 
1 (Enabled) 
 Example usageCommand line: sm -
httpPort:13080 –debugnode:1 –soap12binding:1 
Initialization file: soap12binding:1 

QCCR1E79951 Add documentation for the new 
sqlStats parameter. 

The new sqlstats parameter was introduced to 
allow statistics from an Oracle database to log in 
the sm.log file. 
See sqlstats. 
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Known Problems, Limitations, and Workarounds 

This software release has the following known issues. 

Global ID  Known Issue  Workaround  

QCCR1E76337 Warning messages will be printed to 
the sm.log file when creating a new 
incident and then updating the new 
incident. 

To avoid this issue, install the unload file 
QCCR1E77312_SM930.unl available here:  
https://patch-hub.corp.hp.com/crypt-
web/protected/viewContent.do?patchId=QCCR1E77
312_SM930 

 

https://patch-hub.corp.hp.com/crypt-web/protected/viewContent.do?patchId=QCCR1E77312_SM930
https://patch-hub.corp.hp.com/crypt-web/protected/viewContent.do?patchId=QCCR1E77312_SM930
https://patch-hub.corp.hp.com/crypt-web/protected/viewContent.do?patchId=QCCR1E77312_SM930
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Installation Notes 

Digital signature notice 
HP signs Windows executable files with a digital signature. Since SM 9.30.p3, this process has been updated 
to use a new VeriSign root certificate. On a Windows system that does not have the new VeriSign root or 
intermediate certificate installed, when the user right-clicks the file and then goes to Properties > Digital 
Signatures > Details, a verification error will display: “The certificate in this signature cannot be verified.”   

 
To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as 
documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140 

Web Tier Installation 

The Web Tier update consists of a compressed file, sm9.30.511-P5_Web_Tier.zip. The specific upgrade 
process depends on your particular Web application server, but follows the same steps as deploying a new 
installation. 
The Service Manager Web Tier contains a J2EE-compliant web application that runs on your web 
application server. Each web application server has its own method of deploying web applications. See your 
web application server documentation for specific instructions on deploying a web application. 
The upgrade does not automatically save your Web Tier customizations. To keep your changes, you must 
save your customized files and replace the new version of these files with your customized version. For more 
information, refer to the Service Manager Interactive Installation Guide. 
Note: For an updated example of deploying the web tier, see Deploying the Service Manager Web Tier on 
WebSphere Application Server 7, included in the Service Manager 9.30p2 Release Notes. 

1. Back up your web.xml file, splash screen, style sheets, and any other customizations you made, 
including your webtier-9.30.war (webtier-ear-9.30.ear) file.  

https://knowledge.verisign.com/support/ssl-certificates-support/index?page=content&actp=CROSSLINK&id=SO19140
https://knowledge.verisign.com/support/ssl-certificates-support/index?page=content&actp=CROSSLINK&id=SO19140
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2. Delete or uninstall the existing webtier-9.30.war or webtier-ear-9.30.ear file. 

3. The "Update Application" function in WebSphere application server allows you to redeploy using a new 
copy of webtier-9.30.war (Webtier.ear-9.30.ear). First, update the web.xml in the webtier-
9.30.war (Webtier.ear-9.30.ear.ear) file, and then redo the shared library configuration. For more 
information, see the IBM WebSphere documentation. 

4. Deploy the new webtier-9.30.war (Webtier.ear-9.30.ear.ear) file by following the instructions in the 
Service Manager Installation Guide.  
Note: HP recommends that you deploy with a unique context root, for example /webtier-9.30.511. 

5. Replace the new versions of any files you customized with your customized versions. 
6. Make any new customizations necessary for your deployment. 
7. Restart the Application server.  

Note: Before accessing the new Web Tier, HP recommends that all users empty their browser cache. 

Windows Client installation 

The Windows client update consists of a compressed file, sm9.30.511-P5_Windows_Client.zip, which 
contains the executable installation files. 

To install the Windows client update: 
1. Stop the Service Manager Windows client. 
2. Uninstall the Service Manager Windows client. (Your connection and personalized settings are retained.) 

3. Run setup.exe and install the client by following the instructions in the Service Manager Installation 
guide and Release Notes for your version. 

4. Check the version in Help > About Service Manager Client.  
The client should be Release: 9.30.511. 

Server Update Installation 

The server update for your operating system (OS) consists of a compressed file, sm9.30.511-P5_<OS>.zip  
(or .tar), which contains the Service Manager server files. These files add to or replace the files in the  
[SM Server Root]\ ([SM Server Root]/) RUN, irlang, legacyintegration, and 
platform_unloads directories. 

Important: This server update includes an upgrade of the embedded Tomcat to version 6.0.35. It also 
includes an updated version of the schemastub.xml file (\RUN\km\styles\schemastub.xml), which contains 
changes required for the new KM search result sorting feature (see enhancement QCCR1E67750 and SOLR 
Search Engine Update Installation).  
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To install the Server update: 
1. Stop all Service Manager clients. 
2. Stop the Service Manager server. 
3. Make a backup of the RUN directory. 
4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.35 when you 

extract the server files later. 
5. Delete the RUN/lib directory. 
6. Extract the compressed files for your operating system into the main Service Manager directory on the 

server. The default path is: C:\Program Files\HP\Service Manager 9.30\Server. 

7. For UNIX servers, set the file permissions for all Service Manager files to 755.  

8 If you have made any customizations/changes to the original RUN/tomcat folder, restore them in the 
new RUN/tomcat folder. 

9 Your old schemastub.xml  file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been 
updated to the new version. If you want to use the new KM search result sorting feature, follow the steps 
described in SOLR Search Engine Update Installation; otherwise, copy your old schemastub.xml file 
back. 

10 Make sure the server is stopped, and run the "sm -unlockdatabase" command. 
The purpose of this step is to prevent stale license information from being kept in the system. In a 
scaling implementation, you can run this command from any one of your servers. 
Note: This step is required the first time you upgrade to 9.30P5; it is also required whenever you change 
the server’s IP address after the upgrade. 

11 Restart the Service Manager server. 

12 Restart the Service Manager clients. 

13 Check the version in Help > About Service Manager Server.  
The server should be Release: 9.30.511. 

Application Unload Installation 

If a platform fix (in most cases, a server fix) also requires an applications change to resolve the relevant 
issue, an unload file is provided. Unload files introduced in earlier patches are also included in this 
cumulative release. If you have not already applied them for a previous patch, you should also apply the 
unload files that are intended for your applications version. For more details about these applications 
updates, see the Release Notes for those patches. 

When you extract sm9.30.511-P5_<OS>.zip (or .tar), the unload files are added to your [SM 
Root]\platform_unloads ([SM Root]/platform_unloads) directory. 

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 should be 
applied first, then those introduced in patch 2, and so on. However, unload files introduced in the same 
patch can be installed in a random order. 

Unload File Naming Convention 

The unload files use the following naming convention: <CR_ID>_SMXXXPxx_SMxxx.unl, where: 

• <CR_ID>: The identification number of the applications defect that the unload file fixes. For example, 
QCCR1E12345. Note that this is always the number of the parent CR of a CR family (if any). 
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• SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, 
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch 2 
and should be used for patch 2 or later.  
Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. This 
example means the unload file is intended for Service Manager 7.11 patch 16 Hot Fix 8 or later.  

• SMxxx: The Service Manager applications version that requires the unload file. For example, SM711, 
which means the unload file is intended only for Service Manager applications version 7.11. 
Note: If the applications version suffix is omitted, the unload file is then intended for all applications 
versions compatible with the server version, unless otherwise specified. For example, 
QCCR1Exxxx_SM930P5.unl is intended for applications versions 7.11, 9.20, and 9.30 (which are 
compatible with Service Manager server 9.30), unless otherwise specified in the unload file description. 
For information on the applicable applications versions for each unload file included in the current 
patch, see Unload Files Included in the Current Patch. 

Unload Files Included in the Current Patch 

The following are unload files included in the current patch release.  

Unload file  Introduced 
in  9.30 
patch 

Used for 
apps 
version(s) 

Description 

QCCR1E71099_SM930P5_SM930.
unl 

P5 9.30 Allows Value Lists to be displayed in a 
QBE list when adding a field by using 
Modify Columns. 
Associated server fix: QCCR1E71099 

QCCR1E71139_SM930P5_SM930.
unl 

P5 9.30 Prevents the user from being forced to 
change their password if the user is 
expired in the local database.  
Associated server fix: QCCR1E71139 

QCCR1E31941_SM930P4_SM930.
unl 

P4 9.30 Enables users to use a pre-configured 
decimal symbol when completing 
numeric fields. See QCCR1E31941. 
Notes:  
This enhancement requires the 9.30p4 or 
later server; however if you are using 
RTE version 9.30 with applications 
version 7.11 or 9.20, do not load this 
unload file; you can safely upgrade your 
server to 9.30p4 without applying this 
applications change.  
Associated server fix: QCCR1E31941. 

QCCR1E73452_SM930P4.unl P4 7.11 - 9.30 Enables Mandanten restricting queries 
to be updated correctly after a profile is 
edited. 
Associated server fix: QCCR1E71897. 
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Unload file  Introduced 
in  9.30 
patch 

Used for 
apps 
version(s) 

Description 

QCCR1E67072_SM930P3.unl 
 

P3 7.11 and 
9.20 

Enables users to take advantage of the 
new KMStatusListener background 
process. 
Note: This unload file is not needed for 
applications version 9.30, which supports 
only the SOLR Search Engine. 
Associated server fix: QCCR1E67071. 

QCCR1E70163_SM930P3_SM711.
unl 

P3 7.11 Fixes the issue that the KMUpdate 
process terminates abnormally. 
Associated server fix: QCCR1E69687.   

QCCR1E70163_SM930P3_SM920.
unl 

P3 9.20 Fixes the issue that the KMUpdate 
process terminates abnormally. 
Associated server fix: QCCR1E69687. 

QCCR1E70163_SM930P3_SM930.
unl 

P3 9.30 Fixes the issue that the KMUpdate 
process terminates abnormally. 
Associated server fix: QCCR1E69687. 

QCCR1E67647_SM930P3.unl  P3  7.11 - 9.30  Updates the exception message that 
occurs in the request response when 
closing an interaction by calling 
CloseInteraction from a web service 
without specifying the localSolution field 
in the request.  
Associated server fix: QCCR1E54192. 

QCCR1E67610_SM930P2.unl P2 7.11 - 9.30 Enables you to block potentially 
dangerous attachments. 
Associated server fix: QCCR1E64290. 

To load an unload file: 
1. Select either client or server-side unload, depending on the location of the unload files. 

b From the Windows client, go to Window > Preference > HP Service Manager. 

c Flag Client-Side Load/Unload if the files are on the client machine, and clear the flag if they are 
on the server. 

d Restart the Windows client if you changed the setting. 
2. Open Tailoring > Database Manager. 
3. Right-click the form or open the options menu and select Import/Load. 
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4. Fill in the following fields. 

Field Description 

File Name Type the name and path of the file to load. 

Import Descriptor Since unload files do not require an Import Descriptor record, leave this field 
blank. 

File Type Select the source operating system of the unload file. 

Messages Option —  
All Messages 

Select this option to see all messages that Service Manager generates loading the 
file. 

Messages Option —  
Totals Only 

Select this option to see only the total number of files Service Manager loads. 

Messages Option — 
None 

Select this option to hide all messages that Service Manager generates when 
loading the file. 

Note: You can view the contents of an unload file before importing it by clicking List Contents. 
5. Click Load FG. 

Knowledge Management Update Installation 

The Knowledge Management package (sm9.30.511-P5_KM.zip) includes the following: 
SOLR Search Engine files: 

• An updated schema file 
(\knowledgemanagement\kmsearchengine\KMCores\kmcore\conf\schema.xml)  

• tg_solr.jar (\knowledgemanagement\kmsearchengine\lib) 
In addition, the following SOLR Search Engine unload files included in this patch release.  

Unload file  Introduced 
in  9.30 
patch 

Used for 
apps 
version(s) 

Description 

QCCR1E75104_SM9.30P5_SM930
.unl 

P5 9.30 Reconstructed the query string for "None 
of these words".  
 
Specifically, the behavior of all the 
"Filter by..." fields ("All of these words", 
"The exact phrase", "Any of these words" 
and "None of these words") are aligned 
and put into the filter query.  
 
Consequently, the words in these 4 fields 
are not going to be highlighted; This is 
because of the "filter by..." is meant to 
limit the search scope before actually 
query. 
Associated server fix: QCCR1E75104 
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Unload file  Introduced 
in  9.30 
patch 

Used for 
apps 
version(s) 

Description 

QCCR1E77409_SM930P5_SM930.
unl 

P5 9.30 Adds a new "attachment" field for 
attachment which will not be 
highlighted. 
Associated server fix: QCCR1E77409 

QCCR1E67750_SM930P4_SM930.
unl 

P4 9.30 Adds new sort options ("Sort by Multiple 
Fields," "Relevancy, " "Modified date," 
and "Status"). 
Important: For end-users to use this 
feature, administrators must do the 
following:  

• Upgrade the server to 9.30p4; 
Install the SOLR Search Engine update 
provided in 9.30P4. 
Associated server fix: QCCR1E67750 

Updated Knowledge Management Import Utility 

• km-import-9.30.zip, which is an updated version of the entire import utility. 

SOLR Search Engine Update Installation 

The SOLR Search Engine update in this release enables users to specify their search result sort preferences 
in Knowledge Management (by Modified Date, Status, or Relevancy). 
The Search Engine update consists of the following files in the Knowledge Management package 
(sm9.30.511-P5_KM.zip): 

• An updated schema file 
(\knowledgemanagement\kmsearchengine\KMCores\kmcore\conf\schema.xml)  

• An unload file (kmsolr_unloads\QCCR1E67750_SM930P4_SM930.unl) 
Important: To use this new feature, you must upgrade your Service Manager server to 9.30P5 (in which the 
server’s schemastub.xml file (\RUN\km\styles\schemastub.xml) has been updated to support this new 
feature); in addition, updating your schema.xml file requires a full re-indexing of your knowledgebases. If 
you do not want to use this new feature, you can safely upgrade your Service Manager server to 9.30p5 
without applying this Search Engine update, but you will need to restore your old schemastub.xml. See the 
steps below. 
Warning: The Service Manager 9.30p3 release once provided an updated version of the SOLR Search 
Engine, which was intended to enable this new KM search result sorting feature. However, the 9.30p3 
Search Engine had several known issues as described in the 9.30p3 patch warning, and now it has been 
removed from Service Manager 9.30p3. If you have already installed the 9.30p3 Search Engine, follow the 
instructions in the patch warning to fix the issues; otherwise update your SOLR Search Engine as described 
in the following.  
To install the SOLR Search Engine update: 
1. Upgrade your Service Manager server to 9.30P5. See Server Update Installation. 

Note: Be sure to make a backup copy of the RUN folder. 
2. Restore your customizations to the server’s schemastub.xml. 
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a) If you do not want to use the new KM search result sorting feature, simply copy your old 
\RUN\km\styles\schemastub.xml back from the backup copy of your RUN folder, and ignore the 
following steps.  

b) If you want to use this sorting feature, add the two lines in bold to the <!-- <fields added by SM --> 
section in your old schemastub.xml and then copy this file back. 

  <field name="kmsearchcategory" type="text_plain" indexed="true" stored="true" 
multiValued="true"/> 

  <field name="categorystr" type="text_ws" indexed="true" stored="true" multiValued="true" 
omitNorms="true" /> 

  <field name="kbname" type="text_plain" indexed="true" stored="true"/> 

  <field name="sysmodtime" type="date" indexed="true" stored="true"/> 

  <field name="kmstatus" type="text" indexed="true" stored="true"/> 

  <field name="kbtitle" type="text" indexed="true" stored="true"/> 

  <field name="View_URL" type="text" indexed="true" stored="true"/> 

  <field name="VLang" type="text" indexed="true" stored="true"/> 

  <field name="_style" type="text_plain" indexed="true" stored="true"/> 

3. Make a backup copy of your Search Engine’s schema.xml file 
(<Search_Engine_Home>\kmsearchengine\KMCores\kmcore\conf\schema.xml). 

4. Stop your SOLR Search Engine instance. 
5. Extract the sm9.30.511-P5_KM.zip file to a local directory on your Service Manager server or client host. 

For example, C:\Temp. 
6. Update your existing schema.xml file, which is located in the 

<Search_Engine_Home>\kmsearchengine\KMCores\kmcore\conf directory. 
Note: If you did not tailor your old schema file, you can directly overwrite it with the new schema.xml 
file in the KM package, instead of updating it as described below. 
a) Open both of the old and new schema.xml files in a text editor. 
b) Copy the following lines from the new file to the same section (<!-- Fields added by SM -->) in 

the old file and save it: 
<field name="sysmodtime" type="date" indexed="true" stored="true"/> 

<field name="kmstatus" type="text" indexed="true" stored="true"/> 

The updated section of your old schema file now should look like the following: 
<!-- Fields added by SM --> 

   

  <field name="attachment" type="text" indexed="true" stored="true" 
multiValued="true"/> 

  <field name="sedocid" type="string" indexed="true" stored="true" required="true"/> 

  <field name="docbody" type="text_ws" indexed="true" stored="true" 
multiValued="true"/> 

  <field name="docbody_en" type="text_en" indexed="true" stored="true" 
multiValued="true"/> 

  <field name="docbody_es" type="text_es" indexed="true" stored="true" 
multiValued="true"/> 

  <field name="adlearn_en" type="text_en" indexed="true" stored="true" 
multiValued="true"/> 

  <field name="adlearn_es" type="text_es" indexed="true" stored="true" 
multiValued="true"/> 

  <field name="kmsearchcategory" type="text_plain" indexed="true" stored="true" 
multiValued="true"/> 
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  <field name="categorystr" type="text_ws" indexed="true" stored="true" 
multiValued="true" omitNorms="true" /> 

  <field name="kbname" type="text_plain" indexed="true" stored="true"/> 

  <field name="sysmodtime" type="date" indexed="true" stored="true"/> 

  <field name="kmstatus" type="text" indexed="true" stored="true"/> 

  <field name="kbtitle" type="text" indexed="true" stored="true"/> 

  <field name="View_URL" type="text" indexed="true" stored="true"/> 

  <field name="VLang" type="text" indexed="true" stored="true"/> 

  <field name="knowledgebase_name" type="text_plain" indexed="true" stored="true"/> 

  <field name="_style" type="text_plain" indexed="true" stored="true"/> 

    

<!-- end of SM Fields --> 

7. Log in to Service Manager, and do the following: 
a) Load QCCR1E67750_SM930P4_SM930.unl into your system.  
b) After the unload file is successfully loaded, execute script library KMSearch_SortOrder to update 

the kmknowledgebase search format (kmknowledgebase.search.g). To do so, type sl in the 
command line, open script library KMSearch_SortOrder, and click Execute.  

Note: This update will not overwrite your existing tailoring to the format. 
c) Log off Service Manager for the changes to take effect. 

8. Restart your SOLR Search Engine. 
9. Log back in to Service Manager, and do the following: 

a) Verify your search server connections. 
b) Perform a Full Reindex for each of your knowledgebases. 
c) Perform a knowledgebase search, to verify that the search result sort preferences are working 

correctly. For a description of the preferences, see enhancement QCCR1E67750. 
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Knowledge Management Import Utility Installation 

Extract km-import-9.30.zip in the Knowledge Management package (sm9.30.511-P5_KM.zip) to a local drive. 
For detailed instructions on the use of the import utility, see the README file packaged in the km-import-
9.30.zip file. 

ODBC Driver Update Installation 

The ODBC Driver update consists of the sm9.30.511_P5_ODBC.zip file, which contains the following 
updated files: 

• Scodbc32.dll 

• sci18n.dll 

• sccl32.dll 
To install the ODBC Driver update:  
1. Extract the files to your ODBC Driver installation folder, for example: C:\Program Files\Peregrine 

Systems\ServiceCenter 6.2\ODBC Driver. 

2 When prompted, replace the three old DLL files with the new ones. 

Mobile Applications Update Installation 

The Mobile Applications package (sm9.30.511x_Mobility.zip file) contains an updated version of the 
mobileItsmWebApp.war file.  
To install the Mobile Applications update: 
1. Install Service Manager Mobile Applications version 1.0 shipped with the Service Manager 9.30 DVD, if 

you have not already done so. For detailed instructions, see the HP Service Manager 9.30 Mobile 
Applications User Guide.    
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2 Make sure that the Apache Tomcat SMmobility Windows service or the Mobile Applications Tomcat 
server is stopped.  

3 If you have already configured Mobile Applications version 1.0 on your system, make a backup of the 
following folder by renaming it: <SM_Mobility>\Tomcat\webapps\mobileItsmWebApp 
For example, rename it to mobileItsmWebApp_old. 

4 Copy the mobileItsmWebApp.war file packaged in the sm9.30.511_Mobility.zip file to the following folder 
to overwrite the old mobileItsmWebApp.war file: <SM_Mobility>\Tomcat\webapps\ 

5 If you have already configured Mobile Applications, restore your customizations by copying your old 
AppConfig.groovy and CustomConfig.groovy files back to overwrite the configuration files in the new 
mobileItsmWebApp.war file; if you have not done any configuration yet, configure the Mobile 
Applications by following the instructions in the user guide. 

6 In <SM_Mobility>\Tomcat\conf\server.xml, add the URIEncoding="UTF-8" attribute for the HTTP 
connector as shown below: 
<Connector port="8080" protocol="HTTP/1.1"  

               connectionTimeout="120000"  

               redirectPort="8443" URIEncoding="UTF-8" /> 

7 Start the Apache Tomcat SMmobility Windows service or start the Mobile Applications Tomcat 
server.   The following new folder is created: <SM_Mobility>\Tomcat\webapps\mobileItsmWebApp 
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Backout Instructions 

If you want to restore your Service Manager system to its original state after installing Service Manager 
9.30, follow these guidelines. 

Server 

Before applying the server patch, make a backup of the server installation folder. For example, C:\Program 
Files\HP\Service Manager x.xx\Server. 
To roll back your server to its original state, remove the existing server installation folder and copy the old 
one back. 

Applications 

When loading an unload file 

Before loading an unload file, perform the following steps to make a backup of the files to be modified by the 
unload file: 

1. Go to Database Manager, select Import/Load from More or the More Actions menu, and browse 
to the unload file. 

2. Click List Contents on the menu bar, to view a list of files that have been updated in this unload. 
3. Go to Tailoring > RAD Editor, search for the files you got in step 2, and click More > 

Export/Unload.  
4. In the popup window, specify your backup upload file path/name, and click Unload Appl. Note: 

Make sure that Append to file is selected. 

When applying an application patch 

Before applying an application patch, make a backup of your database. To roll back your application 
changes, restore your database to the backup. 

Web Tier 

Before deploying the new web tier, back up your web.xml file, splash screen, style sheets, and any other 
customizations you made, including your webtier-9.30.war (webtier-ear-9.30.ear) file.  

To roll back to the old web tier: 
1. Delete or uninstall the existing web tier. 
2. Redeploy the old web tier. 
3. Restore your old customizations.  

Windows Client 

You can only uninstall the new Windows client, and then reinstall the old one. 
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Verified Environments 

The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software products, 
and other compatibility and support information.  

To access the Compatibility Matrix:  
1. Use a browser to navigate to the Software Support Online (SSO) web page:  

http://support.openview.hp.com/sc/support_matrices.jsp 
2. Log on with your Customer ID and password or your HP Passport sign-in.  
3. Navigate to the applicable information.  

Local Language Support 

UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 
language. Service Manager 9.30 supports UTF-8 as an encoding method for new or existing data. It can 
support multiple languages that adhere to the Unicode standard on the same server. 

Support 

You can visit the HP Software support web site at: 
www.hp.com/go/hpsoftwaresupport 
This web site provides contact information and details about the products, services, and support that HP 
Software offers.  
HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 
• Search for knowledge documents of interest 
• Submit and track support cases and enhancement requests 
• Download software patches 
• Manage support contracts 
• Look up HP support contacts 
• Review information about available services 
• Enter into discussions with other software customers 
• Research and register for software training 
Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 
http://h20230.www2.hp.com/new_access_levels.jsp 

http://support.openview.hp.com/sc/support_matrices.jsp
http://h20230.www2.hp.com/new_access_levels.jsp
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To register for an HP Passport ID, go to the following URL: 
http://h20229.www2.hp.com/passport-registration.html 

http://h20229.www2.hp.com/passport-registration.html
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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 
The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notice 

© Copyright 1994-2013 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

• Adobe™ is a trademark of Adobe Systems Incorporated. 
• Java™ is a registered trademark of Oracle and/or its affiliates. 
• Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation. 
• Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California. 
• UNIX® is a registered trademark of The Open Group. 
For a complete list of open source and third party acknowledgements, visit the HP Software Support Online 
web site and search for the product manual called HP Service Manager Open Source and Third Party 
License Agreements. 
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